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Overview of Presentation

 Introduction to the Surface-water Modeling 
System (SMS v.13.0)
 What is it?
 Tools, Modules, Data Tree, Images, etc.
 CMS Models interface

 Introduction to the Coastal Modeling System 
(CMS)
 CMS-Flow – Hydrodynamics, Sediment Transport, 

Morphology Change
 CMS-Wave – Half-plane waves and Full-plane wind 

forcing.



CMS Overview

Since 1997…
 >70 workshops
 Districts can independently 

run the CMS!

Advantages…
 Robust
 Physics-based
 Integrated SYSTEM
 In SMS
 User-friendly
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What is the SMS?

 A Pre-Processor
 Organize and create input files for Corps of 

Engineers’ numerical models

 A Post-Processor (visualize results)
 Create plots
 Create film loops
 Data calculator
 Dataset creation

 Connect with outside tools
 Import/export CAD data
 Import/export GIS data
 Import/export tabular ASCII data
 Import/export image data



5

Overview of SMS interface
The SMS interface is modular.  Separate modules pertaining to each data type. As the user 

switches from one module to another, the menus and tools change. Inside the modules, the 
user associates a numerical model with a mesh or grid. When that grid is active, the tools and 
menus for the associated model are also enabled. 

The SMS screen includes several toolbars, edit fields, and menus. Some of these change as the 
user switches modules or numerical models. The principal components include: 

• Menu Bar - Menu to issue commands. These change as the module and model change. 
• Edit Window - Fields directly below the menu bar showing the coordinates and function values 

for selected entities. 
• Graphics Window - Display panel to show the data being manipulated. 
• Project Explorer (Data Tree) - Tree representation of data currently referenced through SMS. 
• Time Step Window – Appears if transient data are available. 
• Toolbars - Several toolbars can be displayed. For more information on each toolbar, see the 

Toolbars article. 
• Help or Status Window

The toolbars, project explorer, time steps window, and edit window are dockable windows. 
Dockable windows may be positioned by the user. 

http://www.xmswiki.com/xms/SMS:Modules
http://www.xmswiki.com/xms/SMS:Menu_Bar
http://www.xmswiki.com/xms/SMS:Toolbars
http://www.xmswiki.com/xms/SMS:Toolbars
http://www.xmswiki.com/xms/SMS:Edit_Window
http://www.xmswiki.com/xms/SMS:Menu_Bar
http://www.xmswiki.com/xms/SMS:Modules
http://www.xmswiki.com/xms/SMS:Models
http://www.xmswiki.com/xms/SMS:Menu_Bar
http://www.xmswiki.com/xms/SMS:Edit_Window
http://www.xmswiki.com/xms/SMS:Graphics_Window
http://www.xmswiki.com/xms/SMS:Project_Explorer
http://www.xmswiki.com/xms/SMS:Time_Step_Window
http://www.xmswiki.com/xms/SMS:Toolbars
http://www.xmswiki.com/xms/SMS:Toolbars
http://www.xmswiki.com/xms/SMS:Help_or_Status_Window


MENU BAR

EDIT WINDOW

GRAPHICS WINDOW

STATUS WINDOW

HELP WINDOW

DATA TREE

TIME STEPS WINDOW

The Data Tree (also 
referred to as the 
“Project Explorer") is a 
dockable window that 
appears by default on 
the left side of the SMS 
screen. 

This window displays a 
hierarchical tree 
structure representing 
all data currently being 
managed in an SMS 
simulation. 

SMS Modeling Suite
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Toolbars
Toolbars
• Static Toolbar

• Dynamic Toolbar
► Grid

► CMS-Flow
► CMS-Wave

► Scatter
► Annotation

• Data Toolbar

• Optional Toolbars
► Macro
► File
► Display

• Module Toolbar
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Tools

Individual Tools
• Static Toolbar

Pan          Zoom         Rotate

• Module Toolbar
Mesh        Cartesian Grid      Scatterpoint        Map       Particle        Annotations

• Data Toolbar
Measurement Tool          Get Data Tool 

• Optional Toolbars
• Macro

Shading       Contours       Vectors       Info       Plot Wizard
• File

Open         Save         Print        Delete
• Display

Refresh          Frame       Display Options        Plan View
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Cartesian Grid / Quadtree tools
 Select Cell, Row, and Column
 Split Column and Row
 Move Column and Row Edges
 Select and Create Cellstrings
 Create Grid Frame
 Apply Contour Labels

Scatter Data tools
 Select and Create Point
 Select and Create Breakline
 Select and Create Triangle
 Flip Triangle Edge

Map Data Tools
 Select Feature Node
 Create Feature Node
 Select Vertex
 Add Vertex
 Select Feature Arc
 Create Feature Arc
 Select Feature Polygon
 Create 2-d Grid Frame
 Select 2-d Grid Frame

Selection tools usually have an arrow that 
points to the specific type of element.

Creation tools are identical to selection 
tools, only they do not have the arrow.

Dynamic Toolbar
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Data Tree Components

 The Data Tree makes selection of loaded 
datasets easy.  Simply click on a dataset to 
make it active, and the graphics window 
updates accordingly.

 There are several “right-click” options 
available depending on the type of dataset 
activated, and within which module it is 
located. A few of these are:
 Basic Dataset Information
 Dataset-specific contour options
 Export to file
 Metadata Information

 The display of each asset in the Data Tree 
can be turned off by unchecking the display 
box next to the dataset name.
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SMS – a complete modeling interface

Import Background Data
• Topographic & bathymetric data –

numerous formats supported
• Images – maps & aerial photos
• CAD, GIS & spreadsheet data

Create Conceptual Model
• Delineate CMS model domain
• Define areas of finer resolution

Generate & Run CMS Models
• Automatically generate grid
• Interpolate depths from background data
• Utilize built-in interfaces to define model-specific parameters 

and boundary conditions
• Run model and visualize results

Build a CMS model from start to finish – all within SMS
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SMS – Data Processing
Import Wizard
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Scattered Data (TINs)

 Stores spatially varied data
► Bathymetric data most common

► Interpolates from one grid/mesh 
to another

► Allows combination of data 
sources

► Facilitates data thinning or 
filtering
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Visualization of Scattered Data

Humboldt Bay, CA
Oblique view

Z-magnification 5x

 Options
 Magnify in Z direction

 Oblique or plan views

 Fill with contours options

 Shading
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Lidar Survey
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Breaklines 
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Operating With Scatter Sets

 Right Click 
Menu 

 Merge
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Points and Triangles

 User can delete points or 
triangles to change 
extents of a set.

 User can swap edges to 
alter shape of surface
 Used in linear interpolation
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Images

Topo Maps Aerial Photos
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Image Data

Overlay data over images
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CMS-Flow Interface: Pull-down menus

The Data pull-down menu contains many items – here are a few:
• Dataset Toolbox – Dataset-based operations (includes Calculator)
• Vector/Contour Options – Change appearance of data within the Graphics 

Window
• Film Loop – Generate animations based on loaded data/solutions
• Transform – manually changes geometry properties
• Map Elevation – Define a dataset to be the “Z” (Depth) dataset for a grid

The Display pull-down menu contains commands to manipulate what 
and how data is viewed inside the interface.
• Display Options – Affect visibility of various options
• Lighting Options – Enable and modify an “external light source”
• Projection – Set the default display projection for items loaded into SMS
• View – get information on various selections for later reproducibility.
• Plot Wizard – View loaded data in various graphical charts and plots.

The Cells pull-down menu contains options for finding specific cells 
and manipulating one or many selected cells.
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CMS-Flow Model Control
Parameter Specification and File I/O

 Time Control
 Auxiliary Files
 Parameters

 Wet/Dry depth
 Flags

 Process sections to 
Include
 Flow
 Sediment Transport
 Wind
 Waves
 Salinity
 Output options
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CMS-Wave Interface: Pull-down Menus

The CMS-Wave menu contains commands to operate the 
model.

• Model Control – Set up the parameters and running options for a 
CMS-Wave simulation

• Model Check – Analyze present wave grid and modeling parameters 
for errors before run commences.

• Export CMS-Wave files – Writes all the CMS-Wave information out 
to the correctly formatted files.

• Launch CMS-Wave – Runs CMS-Wave with assigned options
• Save project, Export, and Launch – Saves the project and then both 

exports the files and launches the model, all in one step.

The Data pull-down menu uses most of the items as for CMS-Flow:
• Dataset Toolbox – Dataset-based operations (includes Calculator)
• Vector/Contour Options – Change appearance of data within the Graphics 

Window
• Film Loop – Generate animations based on loaded data/solutions
• Transform – manually changes geometry properties
• Map Elevation – Define a dataset to be the “Z” (Depth) dataset for a grid
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Spectral Energy menu

Example of Imported Spectra from Wave Gauge
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Generate Spectra from Bulk Criteria
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CMS-Wave Model Control

 Turn on Wetting & 
Drying of Cells
 Turn on Reflection 

(FWD, BWD)
 Choose Bed Friction 

type
 Set parameters
 Choose Output 

Datasets 
 Choose Wave 

Source
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Dataset Toolbox

 Temporal Operations
 Sample times
 Temporal derivatives

 Mathematical Operations
 Comparisons
 Data Calculator

 Spatial Operations
 Spacing
 Gradients/Derivatives
 Smoothing

 Conversions
► Vector <-> Scalars

 Coastal Functions
► Wavelength/Celerity
► Courant number

 Activity Mapping
► Map activity
► Value filtering
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Dataset Calculator
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Duplicate/Rotate Grid (Cartesian Grids)

 Accessed by Right Click on 
Grid in Project Explorer
 Duplicate Flow grid for Wave 

model or vice-versa
 Rotate Wave grid to 

appropriate orientation
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Coordinate Projections

 All major datums
 Project

 Point
 Object
 Entire project

 Support for projection 
files

 Automatic detection 
of projections
 Images
 CAD
 GIS
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SMS – Post Processing

 Annotations
 Graphic images
 Animations

 AVI filmloops
 kmz – Google Earth Exports

 2D Plots
 Time series
 Profiles and Cross sections – both steady state and 

transient
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Annotation Layers

 Replaces 
Drawing Objects

 New Objects
 Screen space 

images (logos)
 Scale bars
 North Arrows

 Organizes 
entities into 
layers

 Anchored in 
either world or 
screen
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Contour/Vector Plots
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Google Earth (KML) Overlay
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Google Earth Overlay (zoom)
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Obtaining and Activating SMS

http://cirp.usace.army.mil/products/SMS.php

USACE District and ERDC staff –

Contact sms@erdc.usace.army.mil and request a password for any version 
of SMS.  If no response in one business day, contact 
mitchell.e.brown@usace.army.mil to facilitate.

Others –
 Visit http://www.aquaveo.com/password_request for a temporary password.
 Contact Aquaveo sales at sales@aquaveo.com or call 

(801) 302-1400.
 Request evaluation version from within the SMS registration form.

http://cirp.usace.army.mil/products/SMS.php
mailto:sms@erdc.usace.army.mil
mailto:mitchell.e.brown@usace.army.mil
http://www.aquaveo.com/password_request
mailto:sales@aquaveo.com
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Overview of Presentation

 Introduction to the Surface-water Modeling 
System (SMS v.13.0)
 What is it?
 Tools, Modules, Data Tree, Images, etc.
 CMS Models interface

 Introduction to the Coastal Modeling System 
(CMS)
 CMS-Flow – Hydrodynamics, Sediment Transport, 

Morphology Change
 CMS-Wave – Half-plane waves and Full-plane wind 

forcing.
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Objective

 Deliver to engineers’ desktops integrated
advanced models that can be used as practical
engineering tools for coastal inlet and adjacent 
beach studies.
 Integrated: All relevant processes, models efficiently 

coupled together
 Practical: PC-based, user-friendly interface, fast, robust 

and accurate
 Deliver: Manuals, tech reports, journal papers, Wiki, 

workshops, phone help, etc.
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CMS-Flow Key Features

 Finite Volume Method
 Conserves mass
 Stable
 Accessible

 Coupled with spectral wave model 
(CMS-Wave) 
 Wave-current interactions

 Inline sediment transport and 
morphology change 
 Non-equilibrium sediment Transport 

model (NET)
 Nesting capability
 WSE, river, wind/atmospheric pressure 

forcing 
 Tidal constituent forcing
 Multiple Sediment Grain Sizes & Bed 

Layering

Wave & Tide 
driven current Measured

Calculated
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CMS-Flow Key Features

 Grid options
 Non-uniform Cartesian grid: Easy 

to setup (< SMS 12.0)
 Telescoping (quadtree) grid: 

Efficient, flexible (SMS 11.0+)

 Solver options
 Implicit: Tidal flow, long-term 

morphology change. 
~10 minute time step

 Explicit: Flooding, breaching, 
super-critical flow. ~1 second time 
step, parallel processing

Non-uniform 
Cartesian grid

Quadtree grid
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Hydrodynamics

Included terms for the depth-averaged shallow water 
equations in Cartesian coordinates

Depth -averaged current velocity
Total water depth
Still water depth
Water surface elevation 
Gravity
Atmospheric Pressure
Precipitation / Evaporation

Coriolis
Turbulent eddy viscosity
Bottom stress (including waves)
Wave stress (forcing)
Wind stress
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Packery Channel, TX
(very quickly setup and run)

01/12 04/12 07/12 10/12 13/12 16/12

-0.2

-0.1

0

0.1

0.2

W
at

er
 le

ve
l (

m
, M

W
L)

Packery 005

Recorded
Modeled

01/12 04/12 07/12 10/12 13/12 16/12
-1

-0.5

0

0.5

1

Ve
lo

ci
ty

 (m
/s

; -
 e

bb
, +

 fl
oo

d) JFK Bridge 150

Recorded
Modeled

150 005



44

Nested Grid Capability

Tidal Database or 
model results

Nested Grid

Extracted-WSE Extracted U,V, 
& WSE

Larger grid can be: ADCIRC,
CMS-Flow, Tidal Database, etc.
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CMS-Wave: Key Features

 Shoaling, refraction, diffraction, 
reflection

 Bottom friction
 White capping
 Wave breaking (4 options)
 Wind generation
 Wave-current, and wave-wave 

interactions
 Transmission, runup and 

overtopping
 Muddy bottom
 Automatic grid rotation
 Non-uniform Cartesian grid with 

nesting capability
 “Fast Mode”
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Wave Generation
Rita

Hurricane Rita
0400 UTC, 24 September 2005

Matagorda Bay, TX
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Wave Dissipation over Muddy Coast
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Sediment Transport: Key features

 Sediment transport models
 Equilibrium Total Load (Exner equation)
 Eq. Bed Load + Advection-Diffusion (AD) 

Suspended Load 
 Non-Eq. (AD Total Load)

 Sediment transport formulas
 Lund-CIRP 
 Van Rijn
 Watanabe
 Soulsby

 Hard-bottom
 Avalanching
 Bed slope influence on bed load
 Multiple-sized sed. Transport
 Bed Layering
 Eularian Tracking (via Class Fractions)

Pensacola Pass, FL

Channel Infilling ~700,000 cu m

Merrimack Inlet, MA
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Computational Speed (Implicit)

Shark River, NJ
33k cells

Shinnecock, NY
53k cells

1 yr in 1.4 days1 yr in 1.3 days

Gironde Estuary, FR
11k cells

1 yr in 7 hrs!
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Documentation

 CIRP website  Wiki Website

http://cirp.usace.army.mil/ http://cirpwiki.info



Documentation
Website (cirp.usace.army.mil)
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 Products
 CMS
 GenCade
 Others

 Publications
 Technical Reports
 CHETNS
 Journal Articles
 Others

 Tech Transfer
 Webinars
 Workshops
 Video Clips



Documentation
Wiki (cirpwiki.info)
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 CMS 
 Documentation Portal
 Tutorials
 Technical Info 

(Equations)
 Validation Cases

 Gencade
 Information
 User Guide

 CPT/CSMART
 Information and 

Guidance
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SMS and CMS

Questions?

Mitch Brown
Mitchell.E.Brown@usace.army.mil

601-634-4036

Honghai Li
Honghai.Li@usace.army.mil

601-634-2840

mailto:Mitchell.E.Brown@usace.army.mil
mailto:Honghai.Li@usace.army.mil
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